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For information on how to use Help, press F1 or select Using Help from the Help menu.



Tournament Menu
The Tournament menu provides commands for creating a new tournament, opening 
existing tournament (.trm) files, saving tournament files, printing contents 
of the tournament window, and exiting the application.

New         Create a new tournament.
Open         Open an existing tournament.
Close         Close the current tournament.
Save         Save the current tournament if its contents have changed.
Save As         Save the current tournament with a new name.
Print         Print the current document for the selected tournament.
Printer Setup        Set printer characteristics.
Exit         Exit the FIDE Swiss pairing application.



Player Menu
The Player menu provides commands to add, modify or delete players.

Add Player           Add a new player to the tournament. 
Edit Player           Edit an existing player in the tournament.
Delete Player     Remove a player from the tournament. 
Withdraw Player           Withdraw a player from the tournament. 



View Menu
The View menu provides commands to watch different listings related to the 
tournament contestants.

List of Participants     Players ordered after pairing numbers.
Standings             Players ordered after scored points.
Round Pairing       The pairing for the current round. 
Cross Table             The pairing history up to the current round. 



Search Menu
The Search menu provides commands to find a player.

Find Player            Find a player.
Find Next              Find the next match in the search for player.
Find Table                Find the table where the player is playing this round.



Pairing Menu
The Pairing menu provides commands to find a player.

Automatic Pairing         The program computes the pairings for the current 
round.
Manual Pairing               A possibility to perform the pairings manually.
Results              The results are entered for the current round.
Change Round              Go to a given round.
Previous Round        Go to the previous round.
Next Round              Go to the next round.
Undo Pairing              Undo the pairings for the current round.



Rating Menu
The Rating menu provides commands to calculate rating changes and title norms.

Nota Bene : These commands are not programmed yet.

ELO Calculation          Calculate ELO changes up to the current round.
Title Norm Calculation    Calculate possibly obtained title norms.



Help Menu
The Help menu provides access to the help system and the about dialog.

Contents            Help topic contents.
About                      Information about the author and the product.



Exiting
To exit the application, choose Tournament|Exit from the menu.



Printing
There are two commands on the Tournament menu which support printing of 
documents from the application. 

Tournament|Printer Setup is used to select and configure a printer device.  

Tournament|Print causes the current document to be printed.



Tournament |Close
The Tournament|Close command closes the currently active tournament.



Tournament |Exit
The Tournament|Exit command exits the FIDE Swiss pairing system. 

If you have modified documents without saving, you'll be prompted to save 
before exiting.



Tournament |New 
The Tournament|New command creates a new tournament. 

The application prompts you to name the tournament before it is opened.
You also have to enter the number of rounds.



Tournament |Open 
The  Tournament|Open command displays the Open a File dialog box so you can 
select a tournament.

Tournament files are stored as .trm - files for each round in the tournament.



Tournament |Print 
The Tournament|Print command prints the contents of the active window. 

Use Tournament|Printer Setup to select a printer, and to set printer options. 



Tournament |Printer Setup 
Tournament|Printer Setup command displays the Printer Setup dialog box which 
allows you to select and configure the printer to be used to print documents 
in the application.



Tournament |Save
The Tournament|Save command saves the tournament to disk. 

Each consecutive round is saved in a .trm - file. 

If the tournament is called RiltonCup, the first round is saved in rilt01.trm,
the second in rilt02.trm and so on. 

If the tournament has 9 rounds, the final standings are saved in the 
rilt10.trm file.



Tournament |Save As
The Tournament|Save As command allows you to save the tournament with a new 
name, or in a new location on disk. 

The command displays the Save File As dialog box. You can enter the new 
tournament name, including the drive and directory. If you choose an existing 
file name, you are asked if you want to overwrite the existing file. 



Player |Add 
The Player|Add command adds a new player to the tournament. 

This can only be done before round 1 is paired.



Player |Edit
The Player|Edit command gives you the possibility to edit the attributes for a
player in the tournament. 



Player |Delete
The Player|Delete command removes a player from the tournament. 

This can only be done before round 1 is paired. 
Use Player|Withdraw when the tournament has started. 



Player |Withdraw
The Player|Withdraw command withdraws a player from the tournament. 

Use this command after round 1.
The player will be stalled, eg not used for pairing purposes.

If you have entered a player by mistake, for instance when you are adding 
players for a new tournament, you should use Player|Delete.



View |List Of Participants
The View|List Of Participants command lists the players in the tournament 
window.

The players are ordered after their pairing number, which is set before the 
pairing of round 1.



View |Standings
The View|Standings command lists the players in the tournament window.

The players are ordered after scored points, ie their position.



View |Round Pairing
The View|Round Pairing command shows the pairings for the actual round.

In order to view the pairings you have to order the program to calculate the 
pairings first, see Pairing|Automatic.  



View |Cross Table
The View|Cross Table lists the players in the tournament window.

You can observe the players history, ie scored points and colours. 
The players are ordered by pairing number.



Search |Find Player
The Search|Find Player command searches the current listing for a player name.
The search locates a given substring in a player name.  

When a match is found, it is highlighted in the listing; otherwise the user is
notified with a failure message.



Search |Find Next
The Search|Find Next command searches the current listing for the next match 
of a substring in a player name.



Search |Find Table
The Search|Find Table command locates the table where a certain player is 
playing the actual round. 



Pairing |Automatic Pairing
The Pairing|Automatic Pairing command computes the pairings for the current 
round.



Pairing |Manual Pairing
The Pairing|Manual Pairing command gives the user the possibility to arrange 
the pairings manually.

Nota Bene : This function is not programmed yet!



Pairing |Results
The Pairing|Results command requests the results of the pairings in a dialog 
window.



Pairing |Change Round
The Pairing|Change Round command sets the tournament variables to the data 
valid for the given round.

These data are fetched from a .trm - file.



Pairing |Previous Round
The Pairing|Previous Round command sets the tournament variables to the data 
valid for the previous round.

These data are fetched from a .trm - file.



Pairing |Next Round
The Pairing|Next Round command sets the tournament variables to the data valid
for the next round.

These data are fetched from a .trm - file.



Pairing |Undo

The Pairing|Undo command removes the pairings for the current round.



Rating |ELO Calculation
The Rating |ELO Calculation command calculates ELO changes.

Nota Bene : The command is not implemented yet.



Rating |Title Norm Calculation
The Rating |Title Norm Calculation command calculates possibly obtained title 
norms.

This command can only be used after the last round.

Nota Bene : The command is not implemented yet.



Window Help table of contents
The Help|Contents displays the help contents page.



Help    About
The program was crafted in 1996 by Christer Hartman. 
The program uses the amendments to FIDE Swiss Rules up to 1995.

Nota Bene : This is a Beta test version!

The maximum number of players in the Beta test version : 20
The maximum number of rounds in the Beta test version  : 9

All comments about the Beta test version are to be forwarded to the author :

    christer.hartman@mailbox.swipnet.se
The program logs tournament rounds. If you find bugs, I would be most grateful
if you could send these .trm - files to my email address!

The program is written in C++. 



Christer Hartman
I am International Master in chess, but usually I am in front of my computer; 
programming. 

This is my first attempt to construct a C++ - system on my own accord, earlier
work include C programming for the computational brain of a realtime Power 
System Simulator.
 
My intention is to distribute a commercial version.
The commercial version will include ELO & Title Norm calculations. 
The price for the commercial version will be around 700$.

(If you like the beta-version : Send 5$ to my physical address; that will 
enhance   the possibility for an appearance of a commercial version!)

I am possibly interested in writing similar applications on a consultant 
basis. If you are satisfied with the product and need a C++ - programmer 
(Windows), you can send some info either to my email address :

            christer.hartman@mailbox.swipnet.se
or my physical address :

            Christer Hartman
            Vallhornsgatan 24
            124 61 Bandhagen
            SWEDEN
 





The Toolbar

The Toolbar is a row of buttons at the top of the main window which 
represent application commands. Clicking one of the buttons is a quick
alternative to choosing a command from the menu.  Buttons on the 
toolbar activate and deactivate according to the state of the 
application.

ButtonAction Menu Equivalent
Create a new tournament Tournament|New
Open a tournament Tournament|Open
Save the tournament to disk Tournament|Save
Print the active tournament listing Tournament|Print
Go to the previous round Pairing|Previous Round
Go to the next round Pairing|Next Round
Compute the pairings Pairing|Automatic Pairing
Undo the computed pairings Pairing|Undo Pairing
Search for player Search|Find Player
Repeat last Find Player operation Search|Next
View standings View|Standings
Display help file contents Help|Contents





Windows Keys

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Window Keys



Cursor Movement Keys

Key(s) Function
Arrow key Moves the cursor left, right, up, or down in 

a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Pape Up or Page Down Moves up or down in a field, one screen at a 

time.



Dialog Box Keys

Key(s) Function
Tab Moves from field to field (left to right and top to 

bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter 

matches the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and 
executes the command.

Esc Closes a dialog box without completing the command. 
(Same as Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function
Backspace Deletes the character to the left of the cursor.

Or, deletes selected text.
Delete Deletes the character to the right of the cursor.

Or, deletes selected text.



Help Keys

Key(s) Function
F1 Gets Help and displays the Help Index for the 

application. If the Help window is already open, 
pressing F1 displays the "Using Windows Help" topics.
In some Windows applications, pressing F1 displays a 
Help topic on the selected command, dialog box option,
or system message.

Shift+F1 Changes the pointer to  so you can get Help on a 
specific command, screen region, or key. You can then 
choose a command, click the screen region, or press a 
key or key combination you want to know more about.
(This feature is not available in all Windows 
applications.)



Menu Keys

Key(s) Function
Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined 

letter matches the one you type, when a menu has 
focus.

Alt+Letter key Pulls down the menu whose underlined letter matches 
the one you type.

Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application 
you are using.

Key(s) Function
Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized 

icon, including full-screen programs.
Alt+Tab Switches to the next application window, restoring 

applications that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the 

application. (See Help Keys)



Window Keys

Key(s) Function
Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized 

icon, including full-screen programs.
Alt+Tab Switches to the next application window, restoring 

applications that are running as icons.
Alt+Enter Switches a non-Windows application between running in 

a window and running full screen.
Arrow key Moves a window when you have chosen Move from the 

Control menu.
Or, changes the size of a window when you have chosen 
Size from the Control menu.




